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Please Note 
Within 2020 Worksheet, go to Help > Check for Software Updates… to find Software Updates, if available. 

REMEMBER: Files modified in newer versions of the software are not necessarily backward compatible with earlier versions of the 

software.  Compatibility issues appear differently in the various 2020 Office applications: 2020 Worksheet and 2020 Giza will display a 

message about incompatibility; 2020 Cap will cause an error in AutoCAD.  
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Commercial Software 2018.2 Feature Additions 
 

1.1  2020 Giza Import/Export Support for AutoCAD 2019 
2020 Giza AutoCAD Import/Export now fully supports AutoCAD 2019, the most up-to-date and advanced version of AutoCAD available. 

2020 Giza users can now import and export to the AutoCAD 2019 drawing format.  

 

1.2  PNG Files Display when Browsing for Report Images 
PNG files are now displayed with other image formats for use as a Report Image.  All .BMP, .PNG, .JPG, and .DIB files now appear within 

the Open dialog when selecting a Report Image.  

 

1.3  New Knowledge Center Icon 
An updated icon for the Knowledge Center is added to the Help toolbars and menus within the 2020 Office applications.  

 

Example: 2020 Worksheet toolbar button: 

 

 

Example: 2020 Cap toolbar button: 
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Example: 2020 Giza toolbar button: 

 

Example: Help Menu 

 

 

Changes Included in Previous Releases 
 

Commercial Software 2018.0 Feature Additions 

General 

1.4 Knowledge Center added to Help 
All 2020 Office applications now include a link to the Knowledge Center within the Support” section of the Help menu.  A toolbar button 

appears on all Help toolbars across all 2020 Office applications as well.  Both the links and the buttons lead to a webpage where more 

information is available for issues encountered.  The Knowledge Center allows for easy access, at any time, to many topics relating to 

2020 Office applications.  Researching an issue within an application is now possible without contact Support. 
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The help menu choice (2020 Worksheet shown; appears in similar locations in all applications): 

 

2020 Worksheet toolbar button: 

 

2020 Cap toolbar button: 

 

2020 Giza toolbar button: 
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2020 Visual Impression 

1.5 2-pt Perspective 
The control to change between 2-point and 3-point perspective is now located on the “dashboard” controls in 2020 Visual Impression.  

There are now two buttons on the pop-up that appears when clicking on the “Render Mode” button: one for 2-point, and the other for 

3-point. 

 

In addition to the easily accessible 2PT/3PT buttons on the dashboard, 2020 Visual Impression’s “Default Room Settings” now allows 2-

Point Perspective as the default perspective type.  

 

To learn more about 2-point perspective within 2020 Visual Impression, search for “Perspective” within 2020 Visual Impression’s Help 

system. 
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1.6 Show/Hide Architecture – Default Room Settings 
Enhancements relating to Room Architecture appear in 2020 Visual Impression.  The Default Room Settings dialog now allows scenes’ 

architecture items to hidden by default.  The definition of “Architecture” in this instance is the system-placed floor, ceiling, and walls.  

This new ability allows for scenes to open in a “clean” state, with only the furniture and user-placed extras visible by default. 

The Default Room Settings dialog has a checkbox that allows for easy hiding (or showing) of all Room Architecture. 

  

Unchecking this box will cause a scene’s Room Architecture items to be hide when opening a scene, unless the item(s) are specifically 

set to be visible. 

Here is a scene that opens with the “Show Room Architecture” box in Default Room Settings unchecked: 

 

The system-placed floor, ceiling, and walls are not visible when opening the scene.   

When making an item visible intentionally, such as the ceiling, floor, or any wall, that property is set for that item, and the Default Room 

Settings has no effect on that item’s visibility.  To make items visible, select them (items are selectable even when they’re not visible) 

and check the “Visible” box in the item palette in the lower right corner.  
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Once an item is set to be visible in a scene, it will remain visible whenever opening that scene, even if the Default Room Setting is set to 

not show Room Architecture. 
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1.7 Show/Hide Architecture – Dashboard 
The functionality of the “Hide Room Architecture” choice on pop-up that appears when clicking “Hide Items” will now hide the most 

items from the “Room Palette” as well as the floor, the ceiling, all system-places walls.  “Room Palette” items include doors, windows, 

“Arch” items (bulkheads, posts, columns, etc.), Lights, and Fixtures. “Hide Room Architecture” has no effect on items from the “Extras” 

section.  

 

Here is a scene with all architecture items visible: 

 

Clicking on “Hide Room Architecture” will cause everything to hide, except for the furniture items and the items from “Extras”. 
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The scene shows no Room Architecture or ceiling, floor, or system-placed walls. 
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To make items visible, select them (items are selectable even when they’re not visible) and check the “Visible” box in the item palette in 

the lower right corner.  
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Turning on all Room Architecture items is fast and easily done using the controls on the Dashboard.  Clicking on “Show All” will set all 

item’s to “Visible”. 
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2020 Worksheet  

1.8 Validate 
A “Validate” function has long existed in 2020 Worksheet.  Validate checks pricing and other item qualities as set by the user.  This 

function helps to prevent incorrect pricing due to typos or missing a step in the discounting process. 

The existing access to Validate remains, off the Worksheet menu within 2020 Worksheet: 

 

The Validate process is now available as part of the Update Against Catalog function.  By default, the box to add this step to the Update 

process is unchecked.  Once checked, it will remain checked until intentionally unchecked. 
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Checking the box and running the Update Against Catalog function will add some dialogs to the Update workflow, specific to Validate. 

 

The Update Against Catalog process runs as normal… 

 

Once the Update Against Catalog process finishes, a Validate Worksheet dialog appears.  This dialog may be resized to show more items.  

The dialog allows for specific criteria for the Validate process by clicking on the “Criteria…” button.  The Validate Worksheet dialog 

allows for resizing to show more items.  
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The Validate process uses specific criteria, allowing for checking a variety of item properties.  Check the criteria that fits the workflow 

and uncheck those that don’t fit the workflow. 

 

“Validate” is also part of the “Update Against Worksheet” dialog, following the same steps at “Update Against Catalog”.  

 

To learn more about the Validate function, search for “Validate” within 2020 Worksheet’s Help system. 
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1.9 2020 Worksheet changes to support Educational Reports 
Three new reports templates are available to use within 2020 Worksheet.  We created these are report templates based on feedback 

from users that are primarily dealers of educational furniture.  These report templates are read-only, Report Designer cannot modify 

them. 

The report templates ship with the 2020 Office software, installing into the “CrystalReports” folder within the “CAP” 

 folder. 
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These new report templates are accessible in the same way the other shipped Report templates are available: from the “Reports” 

menu, selecting “Apply Report Design” and from the “Report Designs” drop list within Worksheet.  The new report templates appear at 

the bottom of the list, under User-created Report templates, in a separate section so they are noticeably different from the other 

shipped Report templates. 

 

 

The steps to apply these new report templates is the same applying any other report template.  Select one of them using either Reports 

menu, or Report Designs drop-list.  Use these reports with any worksheet file, but to use them to their greatest benefit, the worksheet 

needs to be set up so values specific to items are ready for the report template to display the information in a meaningful way. 

In addition to items’ information, these report templates take advantage of the logo image as set within Worksheet Preferences.  To 

make the new report templates more useful we have added a new image property (“Report Image” that is worksheet-specific and two 

new columns to Worksheet (“Manufacturer Name” and “Catalog Name”).   
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1.9.1 REPORT IMAGE IN WORKSHEET PROPERTIES 

The new worksheet property, the “Report Image”, is set within Worksheet Properties.  One of the new Educational report templates 

require this image but the image has value for other uses as well.    
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The main purpose for “Report Image” is for use in the new “Bid Report with Image” report template.   

The image as set within the Report Image section of Worksheet Properties is a relative path.  This means that Worksheet will “look” for 

the image file at the path provided.  Valid image formats are .BMP, .JPG, and .DIB. 

 

If the image exists in that location, it will appear in the Report Image section, if not found, a placeholder that says “Image not found” 

will appear where the image normally be displays. 
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1.9.2 NEW COLUMNS IN 2020 WORKSHEET 

The two new columns are “Catalog Name” and “Manufacturer Name”.  These columns are visible within the “Catalog Info” group of 

columns in Worksheet Properties (appears when right-clicking on a column and choosing “Customize Columns”).  These columns are off 

by default within Worksheet. 

 

Notes:  

1. The Manufacturer Name and Catalog Name values for items are specific to the version of a Catalog file (.CAT).  These values 

populate as updates to manufacturers’ catalogs occur. 

2. The Manufacturer Name and Catalog Name Columns will appear in distinct locations within “Worksheet Properties” when a 

worksheet created before the 2018 version of Worksheet is open.  For these legacy worksheets, the columns appear at the end 

of the group (Grouped View) or end of the complete list of columns (Standard View). 
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1.10 Educational Report Templates 

1.10.1 BID REPORT 

The “Bid Report” template displays a worksheet’s content, preferable limited to three (3) items, for a “Good-Better-Best” bid scenario.  

When three (3) items are in the worksheet, they display side by side.  Each item displays this information: a Preview Image, Part 

Number, Sell Price, Quantity, Extended Sell Price, and Item Description. 
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This diagram explains the contents of the “Bid Report”: 

 

Applying the Bid Report template to a worksheet that has more than three (3) items, it will go so a second page, displaying three (3) 

items per page until complete. 
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1.10.2 BID REPORT WITH IMAGE 

The “Bid Report with Image” uses the “Report Image” as set in Worksheet Properties.  The image scales to fit a 5” x 5” square area, with 

items displayed to the right of the image.  Images that don’t fit on the first page appear on the following pages. 

The “Report Image” can be any image: a line drawing, a rendered plan view, a rendered 3D view, or even a photograph.  The image 

gives the customer an idea of what the furniture layout will look like, while the preview images of the furniture to the right give more 

detail and information.  
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This diagram explains the contents of the “Bid Report”: 

 

Applying the Bid Report with Image template to a worksheet that has more than three (3) items, it will go so a second page, displaying 

eight (8) items per page until complete.  The space left for the Report Image carries on to later pages. 
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1.10.3 ROOM REPORT 

The “Room Report” report template helps with staging furniture within a space.  “Room Report” shows one item per page, a Preview 

Image of the item, the basic information for that page’s item, and a list of locations.  “Locations” are the Alias 1 values assigned to each 

item.  The location filed also shows the quantity in each location. 

The Preview Image is representative for the item.  If there are multiple items in the worksheet and they have different finishes they are 

consolidate for this report.  The Preview Image for the last instance of that item in the worksheet appears in the report. 

    

This diagram explains the contents of the “Room Report”: 
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Applying the Room Report template to a worksheet each item is on its own page.  The number of pages in the report will be the number 

of unique part numbers in the worksheet. 
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2020 Cap 

1.11 Support for AutoCAD 2019 
2020 Cap now fully supports AutoCAD 2019, the most up-to-date and advanced version of AutoCAD available.  Through the support of 

AutoCAD 2019, 2020 Cap users can take advantage of AutoCAD’s new and useful functions, making their daily work both easier and 

efficient 
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2020 Office Software 2018.2 Corrections/Changes/Additions 

ID Issue Corrected 

2020 Worksheet 

260554 
All changes made to a worksheet by typing in a cell is shown as “change in color” within the Undo & Redo lists of 

actions. 

260543 Discount Name not displaying within Worksheet properly. 

2020 Cap 

245037 
Some items contain line types that are not handled properly during item insertion, resulting in all or part of an 

item’s graphic not displaying. 

249379 
When placing a Special that is contained within a Cap Standard (from within Explorer) an error occurs within 

AutoCAD. 
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Known Issues 
Please be aware of the issues noted below.  Most of these issues affect a small number of users because of the specific or unique 

circumstances under which they occur.  However, 2020 feels it is important to fully disclose these known scenarios and workarounds.  

As always, 2020 strongly recommends you fully check your work yourself prior to submitting orders.  2020 and the supported 

manufacturers cannot be held responsible for incorrect specifications or drawings.  Please refer to your Software End User License 

Agreement for more details. 

1.12 General 
Issue: After installing the latest version of 2020 Office Software, the shortcuts do not update to show the new icons due to the way that 

Windows caches icon images.  

Workaround: The icons eventually switch over to the updated version(s) on their own.  Alternately, manually create new 

shortcuts. 

Issue: When installing catalogs to a non-default location on a 64-bit system (“normal” install, not a Network/Client install) the required 

files for automation may not be located by the software, resulting in Automation Palettes that do not contain all the proper user 

interface elements. 

Workaround: Please contact 2020 Customer Support for in resolving this issue. 

Issue: There are known issues with UNC pathing and 2020 Cap/2020 Worksheet. 

Workaround: 2020 Spaces recommends using mapped drive letters when dealing with folder locations.  NOTE: This can happen 

even when "My Documents" folder maps to a network location instead of your local hard drive. Check with your IT 

administrator to find out if this is your issue. 

Issue: Cannot add content through Preferences in 2020 Cap when installed on Windows 7 or Windows Vista. 

Workaround: Use the Catalog Maintenance feature of the monthly content disk set. 

1.13 2020 Worksheet 
Issue: When repeatedly saving a worksheet, it grows in size.  This can lead to large files. 

Workaround: Periodically use the “Purge” command within 2020 Worksheet.  This command is in the “File” menu. 

Issue: When 2020 Worksheet is set to run in “Windows XP Compatibility Mode” its performance will degrade over time.  (Right-click on 

the desktop shortcut and select the proper item from the pop-up menu.) 

Workaround(s): Do not run Worksheet in “Windows XP Compatibility Mode”. 

Issue: DPP discounts on non-DPP items do not persist through an "Update Worksheet" command 

Workaround: Only use DPP discounts on DPP-supported catalogs. 
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1.14 2020 Cap 
Issue: Toolbars for 2020 Cap running within AutoCAD 2019 display question marks rather than the correct icons on toolbar buttons.   

Workaround: None currently.  This an issue within AutoCAD 2019.  Autodesk assures 2020 that the first service pack for 

AutoCAD 2019 will correct this issue.  

Issue: You install or update 2020 Cap/AutoCAD and the 2020 Cap menu and/or toolbars do not appear in AutoCAD.  Typing “CAP” at the 

command line does nothing or produces the error “unknown command”. 

Workaround: Manually load the correct .ARX file from the “CAP Studio” installation folder.  

Issue: Dependency-related graphics (Canadian and GSA versions of American catalogs and/or manufacturers) do not work with Block 

Replace. 

Workaround: Manually find and replace items.  Using “Highlight by Part Number” or “Highlight by Select” can aid in this 

process. 

Issue: Creating Associated Worksheets for large drawings or updating large drawings with Associated Worksheet information can use 

excessively considerable amounts of memory (by AutoCAD) which may lead to AutoCAD unexpectedly closing.  

Workaround: None currently. In cases where Associated Takeoff fail, the workaround is to use standard visual worksheet 

takeoff; if later it is necessary, update of the drawing against the worksheet.  

Issue: Cap Bounds that overlap may not appear properly in a Worksheet Take-off.  

Workaround: Be sure that Cap Bounds are not overlapping or touching. 

1.15 2020 Cap - Design Automation 
Issue: Problems can occur when opening an XSITE drawing when 2020 Cap is NOT running.  These problems may be related to saving, 

the removal of items from the drawing, and moving items. In some cases, the problem may appear immediately while in other cases it 

will not. 

Workaround: Load 2020 Cap (from the command line in AutoCAD) before opening any drawings with XSITE components 

already in them. 

Issue: Error messages occur when using XSITE in any of the following manners inside of AutoCAD: a) within a Cap Standard; b) as a 

WBLOCK from another drawing; c) using COPYCLIP from one drawing to another; d) inserting one drawing into another. 

Workaround: Currently, there is no workaround to prevent the error messages.  In some scenarios, the error messages occur 

even though there truly is not a problem with the drawing. To use elevations created in one drawing in another drawing, use 

the “SaveAs” function to create the second drawing. If you use XSITE graphics often, have encountered error messages and are 

concerned about your drawing(s), please contact technical support at (800) 638-6002 and we would be happy to discuss the 

problem. 

Issue: When selecting from the dropdown list in the Kimball XSITE Tag Manager, the use of existing tags does not work when those tags 

have skipped options. 

Workaround: Go through the normal process of re-optioning the item rather than selecting a Finish Code. 

Issue: Dependency-related graphics (Canadian and GSA versions of American catalogs and/or manufacturers) do not work with CAPTile 

or AutoConnectors.  Scenario: You have placed graphics into your drawing from a Dependency-related catalog and realize that neither 

CAPTile nor AutoConnectors work on them. 
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Workaround: Use US graphics, after doing a Worksheet take-off, change the catalog of manufacturer codes to the 

corresponding Canadian or GSA codes. 

Issue: 2020 Cap’s Automation functions (AutoHardware, XSite, Panel Builder, etc.) might not work correctly if your regional settings in 

Windows are not set to English. 

Workaround: Set Window’s regional settings to English if you experience a problem and it is necessary to run the specific 

Automation functions that exhibit the problem.  

1.16 2020 Giza 
Issue: 2020 Giza catalog data is designed to work with newer versions of 2020 Giza.  If using an older version, a message will appear to 

that effect. 

Workaround: Update to a newer (preferably newest) version of 2020 Giza. 

Issue: When 2020 Giza runs on Windows 7, Frame Designs will not import into a CDB file from another CDB file (2020 Giza Project). 

Workaround:  With the Frame Designer interface, Export the specific Frame Design from the source CDB and then import that 

exported Frame Design into the current CDB, choosing to import “Design Sets” rather than “Giza Projects”; the exported Frame 

Design will then appear and be able to be imported into the CDB. 

1.17 2020 Visual Impression 
Issue: When visualizing a scene that contains Panel Builder configurations using Trendway Architectural Products (TAP) and/or Volo 

(TML), custom width tiles are not scaled properly within 2020 Visual Impression, but look correct within 2020 Cap.   

Workaround:  Before visualizing in 2020 Visual Impression, convert the ENTIRE drawing to 3D within 2020 Cap.  This will create 

proper instances of the custom tiles so they will scale properly within 2020 Visual Impression. 

Issue: An “Out of Memory” situation may occur when working with very large scenes in Visual Impression.   

Workaround:  Reduce the size and/or complexity of visualized scenes 

Issue: Some items’ 3D images appear to be lower quality when compared to the images as seen in the single item preview used by 2020 

Options. 

Workaround(s): There is no current workaround to this issue.  Quality is directly related to how the 3D shape itself is drawn. 

Please report occurrences of this problem to office.support@2020spaces.com  including the mfg. code, cat code, and part number.  

Issue: Dependent upon the resources of the computer, 2020 Visual Impression may have display issues.  Older or underpowered video 

cards and/or out-of-date video card drivers cause this scenario.     

Workaround(s):  Within 2020 Visual Impression, go to Settings and uncheck the “Use hardware for UI elements 

(recommended)” –and/or-- update your video drivers to a more current version.  

Issue: When viewing a scene in “Side 2D”, a grid pattern will appear when the selection includes a room item.  

Workaround:  Deselect any selected room items and view the scene in “Side 2D”. 

Issue: When you "Apply" back to a visualized worksheet, it grows.  This can lead to large files. 

Workaround: Periodically use the “Purge” command within 2020 Worksheet.  This command appears in the “File” menu. 

 

  

mailto:office.support@2020spaces.com
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Customer Support 
2020 Spaces Customer Services personnel are committed to providing the best possible technical support to all 2020 Office customers.  

For technical support, consult the 2020 Spaces Support Web site at:    

http://www.2020spaces.com/contact-us/ 

Follow this link to be part of the 2020 Community!   

http://www.2020spaces.com/forums/forum/cube/  

Trademarks 
2020 Worksheet, 2020 Cap, 2020 Giza, 2020 Visual Impression, and 2020 Visual Materials are registered trademarks of 2020 

Technologies, Inc. 

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. 

Other trademarks mentioned in this document are registered property of their respective owners. 

 

 

http://www.2020spaces.com/contact-us/
http://www.2020spaces.com/forums/forum/cube/

